
GASWorkS™10.0 Example Estate

If the GDI Window is not automatically displayed, select the View/Edit item from the Graphics
menu list to display the GDI Window.

Note...

Summary

In this example, a new model will be created for a small housing estate. A DXF file of the estate layout will
be used as a background image to the model schematic. The model will be created by tracing over the layout.
Customers will be added along the new mains. The diversified load will be calculated. The pipe sizing
routine will be used to select appropriate pipe sizes for the new system.

Steps

The following assumes that GASWorkS has already been started. If a model is already open, close it by
selecting the Close item from the File menu list. Use the following procedure to work this example.

1) Create The New Model

! From the File menu list, select the New Project item. The Project Specifications screen will be displayed.
Set the following values:

Model Name = Leave As Default Name or Enter New Name
Template Model = Default
Preference Settings = Default
Default Settings = uk
Facility Settings = Default
Pipe/Main Sizing Table = pipe_uk

Attach A Linked Customer Attribute File = Unselect
Attach A Linked Node Attribute File = Unselect
Attach A Linked Pipe Attribute File = Unselect

! Click the Select From Existing DXF Files command button. The File Selection screen will be displayed.
Use the Drives and Directories lists to navigate to the directory containing the desired file - estate_plat.dxf.
Select the file, then click the Continue command button.

! On the Project Specifications screen, click the Continue command button.

! The Graphic Data Interface (GDI) Window will be displayed.
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! Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls
Toolbar.

! Zoom the GDI Image to fill the GDI Display using the Zoom To Fit icon from the lower-left
corner of the GDI Window.

2) Create The Default Settings File

When GASWorkS is first installed it is generally setup for traditional US dimensional units. In this example
we will use units common to the UK gas industry. A default settings file containing UK settings for a low
pressure system is included in the sample files.

To review the file...

! From the Utilities menu list, select the Set Defaults item. The Default Data Values screen will be
displayed.
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If you want to save these settings so that you do not need to reset them in the future, click the
Save As Default command button.

Note...

If the standard property table path (\Program Files (x86)\GASWorkS 10\Prop\) is not displayed
as the current path, click the Change Path Setting command button. The Path Settings screen will
be displayed, find and select the appropriate directory/folder. Click the Close command button
to save the change.

Note...

! Click the Open Settings command button. The File Selection screen will be displayed. Use
the Drives and Directories lists to navigate to the directory containing the desired file -
uk.dfs. Select the file, then click the Continue command button.

! Review the settings on the Default Data Values screen by viewing the contents of each
data tab. On the Dimensional Units data tab, set the Coordinates item to Metres. Click the
Apply Dimensional Units Only command button. When done reviewing the settings, click
the Close command button to close the screen and save the values.

3) Set The Graphic Settings

! From the Graphics menu list, select the Settings item. The Graphic Settings screen will be displayed.

! In the Settings section, set the following values:

Customer Symbol Size = 3 % Of Display Width
Node Symbol Size = 1 % Of Display Width
Refresh Increment = 10 % Of Image

! In the Options section, set the following items:

Allow Data Entry During New Feature Entry = Select

! Click the Apply command button to close the screen and save the values.

4) Set The Property Table Files

! From the File menu list, in the Preferences submenu, select the Property Tables item. The Property Table
Selection screen will be displayed.

 B3PE LLC                                                                                          Engineering & Software Services
Revision - 006, Copyright 2021, All Rights Reserved.

3



GASWorkS™10.0 Example Estate

! Set the following values:

Pipe = pipe_uk
Regulator = Select Any Valid Table
Compressor = Select Any Valid Table
Valve = Select Any Valid Table
Well = Select Any Valid Table
Fittings = uk_fitting

Pipe Sizing Group = pipe_size_group_ukdm

! Click the Close command button to save the changes.

5) Set The Preference Settings

For this model, when we are entering new features, it would be good for the data values for each new item
to be same as the values used for the last entered similar feature. To make this happen we need to select a
specific option in the Preference Settings.

! From the File menu list, in the Preferences submenu, select the Settings item. The Preference
Settings screen will be displayed. Set the following values:

Use Last Record For Default Values = Select

! Click the Close command button to save the changes and close the screen.

6) Check The Image Scale

Zoom into the lower-right portion of the image where the
“hammer head” appears.

! Click the Zoom Window icon from the View
Controls Toolbar. Move the mouse pointer to the
upper-left of the desired location that you want to view
and left-click the mouse. Move the mouse pointer to

the lower-right of the desired location of the area that you want to
view (a window or box should be drawn on the screen as you
move the mouse), and left-click the mouse at the second location.
The GDI Image will be zoomed to the selected zoom window.
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• In general, a pipe is entered by selecting the appropriate “Add Pipe” command, entering the
From Node Location, entering vertex locations (deflection points on a polyline), then finally
entering the To Node Location. Because we selected the Allow Data Entry During New Feature
Entry option in the Graphics Settings, the associated data will be displayed in the Data Panel each
time a new node or pipe feature is added. When this occurs, enter the appropriate data, then click
the Apply Data Values command button to continue.

• You will need to use the various Zoom and Pan commands to display a portion of the
background image to a suitable scale as you add the new pipe segments. If you are not already
familiar with these commands, refer to the GASWorkS User’s Manual or Help Guide for
instructions on using the Zoom and Pan commands.

Note...

Measure the distance between the inner east and west portions of the feature using the Measure Distance
command.

! Click the Measure Distance icon from the Utility Commands Toolbar.

! For the First Point, left-click on the western (north-south) inner line. For the
second Next Point, left-click the mouse on the eastern (north-south) inner line
approximately perpendicular to the first point. Then right-click the mouse to indicate that
the measurement selection is complete.

! The Measured Values screen will be displayed. The actual Absolute Distance is 21.5
metres, the displayed distance should be within +/- 0.5 metres. If it is, continue with the
example. If it is not, something has not been set correctly, perhaps a coordinate or length
dimensional unit - check the values and revise as appropriate. Click the OK command button
to clear the message.

7) Enter The Piping System

The goal of this example is to produce a design similar to the one in Figure 1. The supply or source location
is in the lower-left (southwest) corner of the estate.

 B3PE LLC                                                                                          Engineering & Software Services
Revision - 006, Copyright 2021, All Rights Reserved.

5



GASWorkS™10.0 Example Estate

Figure 1

We will start at the supply point and work around the estate adding the pipes as we go. Zoom to a suitable
GDI Image view using an appropriate Zoom or Pan command (see Figure 2).

Add the first pipe...

! Click the Add Polyline Pipe icon from the Graphic
Construction Commands Toolbar.

! For the From Node Location, move the
mouse crosshairs to the supply point location and left-
click the mouse.

! The Node Data will be displayed in the Data Panel. In
the Hydraulic Data Items section, set the following
values:

Name = Supply Point
Pressure = 30
Pressure Units = Millibar
Pressure Known = Yes Note - The Base Load Known item should

automatically change to “No”.
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If you are graphically selecting a node location, ensure that the pipe ends are “snapped” together
by holding down the Shift key when selecting an existing node location.

Note...

Figure 3

! Click the Apply Data Values command button to continue.

! Select the desired vertices by moving the mouse crosshairs to the desired locations and left-
clicking the mouse. Continue until all of the remaining vertices, including the To Node Location,
have been entered. After the To Node Location has been entered, right-click the mouse.

! The Node Data will be displayed in the Data Panel. The default settings are appropriate for the
To Node. Right-click the mouse.

! The Pipe Data will be displayed in the Data Panel. The default settings are appropriate for the
pipe. Right-click the mouse.

! Continue adding the pipes by panning and zooming as appropriate to work your way around the estate.

! When all of the pipes have been entered, zoom the entire GDI Image by clicking the Zoom To
Fit icon from the lower-left GDI Window. It should look similar to Figure 1.

8) Enter The Customer Locations

A customer data feature will be entered for each potential customer location, similar to Figure 3.
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In general, a customer is entered by selecting the appropriate “Add Customer” command, entering
the customer location, then depending on the command, indicating which pipe (main) the
customer is supplied from. We will use an “auto” assign method so the main will automatically
be assigned - we will not need to identify the supply main. Customer default data is handled
different than the pipe data and node data. Default customer data is set by extracting the data
contents from the last entered customer and applying it to the new customer being entered.
Depending on the “Add” command selected, the Customer Data may be displayed in the Data
Panel each time a new customer is entered. When this occurs, enter the appropriate data, then
click the Apply Data Values command button to continue.

Note...

The Customer Data will only be displayed for the first customer. When using the Add
Multiple Customers - Auto Assign Main command, it is assumed that all of the
customers will have the same data values associated with them. If a customer has a
different set of values, it can be individually revised using the Edit Customer Data
command.

Note...

! Click the Add Multiple Customers - Auto Assign Main icon from the Customer Commands
Toolbar.

! Select the location of the first customer by moving the mouse crosshairs to the desired
location and left-click the mouse.

! The Customer Data will be displayed in the Data Panel. In the Hydraulic Data Items
section, set the following values:

Node Load Application = Diversified
Heating Type = Wet-Central Post 1977
Unit Count = 1
Per Unit Load = -20000
Load Units = kWh
Adjust Load = No
Load Status = On

! Click the Apply Data Values command button to save the changes.

! A prompt will appear to enter the location of the next customer. Select the customer location by
moving the mouse crosshairs to the desired location and left-clicking the mouse. The customer will
automatically be assigned to the closest main. Note - If the main selected by the routine is not the
desired main, it can be changed after all of the customers are entered.

! Continue entering the remaining customer locations. Right-click the mouse after the last customer as been
entered to end the command.
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9) Spot Check The Data

Check the customer main assignments. If an incorrect main assignment is found, use the Reassign
Customer Supply Main command to correct it. To use this command, click the Reassign Customer
Supply Main icon from the Customer Commands Toolbar. Select the customer to be changed, then
select the new supply main by moving the mouse pointer near the desired main and left-clicking
the mouse.

10) Solve The Model

! Click the Solve icon from the lower-right corner of the GDI Window. The Solution Data screen
will be displayed.

! On the Other Settings data tab, set the following values:

Base Pressure = 1013 Millibar
Base Temperature = 15.6 Celsius
Row Reduction Limit = 0
Lower Dampening Factor = 0

! On the Solution Data tab, in the Solution Options section, set the following items:

Reset Unknown Node Pressures To Zero = Select

Diversity = IGE/GL/1 Appendix A5.1.5

! Review the solution parameters, then click the Solve command button. The Solution Log will be
displayed. Review the results, then click the Close command button to close the log.

11) Review The Results

Review the solution results by displaying the flow arrows and pressure values.

! If the flow arrows aren’t displayed, click the Display Flow Arrows icon from the Display
Controls Toolbar.

! Display the pressure values by clicking the Text Display Settings icon from the Display
Controls Toolbar. The Text Display Settings screen will be displayed.
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It might be helpful to turn “off” the display of the customer symbols, to make the
display less cluttered. To turn “off” the display of the customer symbols, click the
Display Customer Symbols icon from the Customer Commands Toolbar.

Note...

Figure 4

! On the Node Items data tab, set the following items:

Display Node Text Items = Select
Transparent Font = Unselect
Node Pressure = Select

! Click the Apply command button to update the display.

The values should be similar to those shown in Figure 4. They will not be the same because all of the pipe
lengths were manually entered, and the pipe length affects the pressure drop and node pressures. If the
pressure values are significantly different, an error occurred during data entry. Review the data values and
the instructions, and correct any errors as appropriate.
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12) Calculate New Pipe Sizes

In this example, our goal will be to minimize pipe sizes while maintaining a minimum system pressure of
21 Millibar. The results using the default pipe sizes appear to be pretty close to the desired result. However,
to demonstrate the use of the Pipe Sizing routine, let’s use it to automatically calculate the pipe sizes which
meet our design goal.

The Pipe Sizing routine has basically three steps that must be completed before it can be used. The first step
is to indicate which pipes in the system can be sized. This step was automatically completed when the model
was built. The default data was set such that the Allow Sizing option was selected for the pipes as they were
entered. The second step is to indicate which pipe sizes can be used. This is done using the Pipe Property
Table. The third step is to indicate the sizing parameters. This is done using the Pipe Sizing Controls in the
Solution Data. Since all of the pipes have been designated for sizing, we will start with the second step.

! To indicate which pipe sizes can be used during the Pipe Sizing routine, from the Edit menu list, select the
Property Tables item. The Property Table Report will be displayed.

! On the Pipe data tab, clear the “Use When Sizing” settings by selecting the Set All Use When
Sizing To ‘No’ item from the Select A Command list. Then indicate that the following sizes can be
used by clicking in the associated Use When Sizing data cell until Yes is displayed:

32mm MDPE SDR11
63mm MDPE SDR11
90mm MDPE SDR11

! Click the Close command button. When prompted whether to save the changes, click the Yes
command button

! Indicate the sizing parameters by clicking the Solve icon. The Solution Data screen will be
displayed.

! On the Pipe Sizing Control data tab, set the following values:

! In the Limit/Check Values section:

Condition Nodes = Empty
Condition Pressure = Empty
System Pressures = 21 Millibar
Pressure Values Are = Minimums
Maximum Velocity = 20 Metres/sec
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! In the Other Settings section:

Pass Limit = 30 Number Of Passes
Path Processing = Flow-Pressure Drop Processing
Optimize By = Size
Facility Type = All Facility Types
Reset Diameters To Minimum Size = Select
Pipe Sizing Table = pipe_uk

! Click the Solve & Calculate Pipe Sizes command button to execute the Solution and Pipe Sizing
routines. The Solution Log will be displayed. Note the last entry on the Solution Log. It should
display, “Pipe Sizing Complete”. If it does, the Pipe Sizing routine was successful. If it does not, an
error occurred during data entry. Review the results, then click the Close command button to close
the log.

Review the results of the Pipe Sizing routine by displaying the node pressures and pipe sizes.

! Click the Text Display Settings icon from the Display Controls Toolbar. The Text
Display Settings screen will be displayed.

! On the Pipe Items data tab, set the following values:

Display Pipe Text Items = Select
Transparent Font = Select
Text Color = Black

Note - Click in the color box. The Color Palette will be displayed. Select
the color “Black”, then click the OK command button.

Pipe Size/Type Code = Select

! Click the Apply command button to update the GDI Display.

The values should be similar to those shown in Figure 5. They may not be the same because all of the pipe
lengths were manually entered, and the pipe length affects pressure drop and pressure drop affects the pipe
size. If the sizes are significantly different, an error occurred during data entry. Review the data values and
the instructions, and correct any errors as appropriate.
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The Pipe Sizing routine yields different results depending on a variety of factors one of which
is the “processing method”. Generally, the method that was specified for this example (Flow-
Pressure Drop Processing) yields the most acceptable results. Depending on the pipe lengths, pipe
segmentation, and customer main assignment associated with your model, your results will vary
from those shown here.

Note...

Figure 5

Notes & Considerations

! In this example, an existing DXF file was used to create a background image to trace over. We assumed
the drawing was to scale and our check indicated that it was. What if it wasn’t? Ideally we would go back
to the original drawing and rescale it in the CAD system used to create the DXF. This would ensure that next
time we used the file it would be to scale. If it is not possible to get access to the original file or you do not
have a way of rescaling the DXF file, the scale and shift values in the Background Image Settings could be
used to adjust the image before tracing over it.

! The model loads only represent the loads of the customers immediately attached to the system. We
probably should consider whether additional loads need to be applied to account for future growth.
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Figure 6

! The supply pressure was given in this example. In reality, if the supply was from a non-regulated (non-
governed) source, for example a main line connection, the supply pressure would need be derived from an
analysis of the upstream system, or from field data collected from pressure recording charts or gauges. In
either case, for a complete analysis, the impact of the new system on the upstream system should be
considered. Adding load to the upstream system will cause the upstream pressures to be reduced, and may
negatively impact both the existing and the new system’s performance.

! In this example, the Pipe Sizing routine was used to select new pipe sizes required to achieve a design
which meet certain design limitations. The results of the routine were not unreasonable but probably not
necessarily the way most folks would design the system. For example, in this case the Pipe Sizing routine
has oversized the first segment. The segment could be downsized from 90mm to 63mm while maintaining
the system pressures within the design limits - see Figure 6.

! The results of the Pipe Sizing routine should never be considered to represent the “final” design, but should
be used as a foundation or “first-cut” for the final design.

! When the Calculate Diversity solution option is used with the Pipe Sizing routine, additional iterations are
required to process the pipe sizes. Because diversity is affected by pipe flow (customers are assigned at the
downstream end of their associated pipe), when a pipe is resized, the flow in the pipe also changes - changing
the diversity associated with that pipe. So when a diversity calculation is included, an initial diversified
solution is achieved, the pipes are sized, the diversity is recalculated, the pipes are resized, and so on until
the diversity and pipe sizes remain constant between iterations. When this condition is achieved, the Pipe
Sizing process is complete.
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